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StrikeRisk is purpose designed 
to carry out the complex, 
laborious calculations of   
IEC/EN 62305-2, results can be 
achieved in minutes rather 
than the hours or days that it 
would take to do the 
calculations by hand.
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—
StrikeRisk v6.0
Introduction

StrikeRisk v6.0 is designed for engineers, 
architects and contractors who are tasked 
with carrying out risk calculations in line 
with IEC/EN 62305-2 Lightning protection 
- Risk management.

IEC/EN 62305-2 is key to the correct 
implementation of IEC/EN 62305-3 and  
IEC/EN 62305-4.

StrikeRisk is purpose designed to carry 
out the complex, laborious calculations of  
IEC/EN 62305-2, results can be achieved 
in minutes rather than the hours or days 
that it would take to do the calculations 
by hand.

The following are some of the key 
features of StrikeRisk v6.0.
•	 Carry out and view multiple Cases  

(risk assessments) under the banner  
of a single project.

•	 Build new projects from one of a 
number of pre-defined templates 
based on variants of IEC/EN 62305-2.

•	 Split the structure under consideration 
into multiple Zones in order to pinpoint 
highrisk areas.

•	 Consider multiple cables connecting to 
the structure.

•	 Consider multiple remotely connected 
structures.

•	 Quick and easy colour coded 
identification of risk factors requiring 
attention.

•	 Full detailed reporting/exporting 
facility.

•	 Detailed online help.

The next few topics will help you to 
get started with StrikeRisk. You will be 
guided through:
•	 Installing StrikeRisk
•	 Activating StrikeRisk
•	 User interface
•	 Basic steps
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Installing StrikeRisk
System requirements

I N S TA L L I N G S T R I K ER I S K

Before installing StrikeRisk v6.0 make 
sure your PC meets the following 
minimum requirements. You need...
Microsoft .NET Framework 4.5  
(installed with StrikeRisk) or Microsoft 
.NET Framework 4.51.

Hardware Requirements (as per 
Microsoft .NET Framework 4.5)
Processor 1GHz
RAM 512MB		
Disk space (minimum)
32-bit 850MB
64-bit 2GB

Supported client operating systems
Windows 8.1 32-bit and 64-bit Include 
the .NET Framework 4.5.1
Windows 8 32-bit and 64-bit Include the
.NET Framework 4.5
Windows 7 SP1 32-bit and 64-bit
Windows Vista SP2 32-bit and 64-bit

For all platforms, we recommend that you 
upgrade to the latest Windows Service 
Pack and critical updates available from
the Windows Update website to ensure
the best compatibility and security.
Installing StrikeRisk  

(based on Windows 7)
Furse recommends that you uninstall any 
older versions or evaluation versions of 
StrikeRisk prior to installing new versions. 
See page 6.

To install StrikeRisk v6.0, you’ll need to 
run the Setup program contained on the 
CD-ROM. Perform the following steps to 
Start the installation of StrikeRisk v6.0.

a. Insert the program CD in the CD-ROM 	
drive of your computer. If your system 
is set to run programs automatically, 
the following dialogue box is displayed 	
from which you can start the
installation procedure
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b. If your system does not support the 	
automatic execution of programs, 	
you can access the contents of the CD 
by selecting Start, Run and Browse. 
You can then go to the relevant directory, 	
typically (D:) StrikeRiskv6.0, where you 
will find the file Setup.exe. Select this
file and click OK. Setup is then 
started manually.

c. A license agreement dialogue box will be 
displayed which should be read carefully. 
The agreement specifies the legal 
conditions under which you may install 
and use the StrikeRisk v6.0 software. If 
you agree to the terms, click Accept to 
continue with the installation. If you do 
not agree with the terms of the license 
agreement then click Don’t Accept and the 
installation wizard will exit.

d. A supplemental licence agreement box 
displays for the Microsoft .NET Framework 
4.5 (x86 and x64). If you agree to the terms 
of the licence agreement, click Accept. If 
you do not agree with the terms of the 
License agreement then click Don’t Accept 
and the installation wizard will exit.
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e. A supplemental licence agreement box 	
displays for the Microsoft System CLR 	
Types for SQL Server 2012 (x86 and x64). 	
If you agree to the terms of the licence 	
agreement, click Accept. If you do not 	
agree with the terms of the License 	
agreement then click Don’t Accept and 	
the installation wizard will exit.

f. A supplemental licence agreement box 	
displays for the Microsoft Report viewer. If 
you agree to the terms of the licence 	
agreement, click Accept. If you do not 	
agree with the terms of the License 	
agreement then click Don’t Accept and 	
the installation wizard will exit

I N S TA L L I N G S T R I K ER I S K
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—
Installation troubleshooting

g. The installation is now ready to begin. 	
When the following dialogue is displayed 	
click the Install button to start the 		
installation. If you wish you can click 
the Don’t Install button to cancel 
the installation.

h. The installation process begins copying 
the files. The progress bar indicates the 
current file transfer status.

i. Once all files have been copied StrikeRisk 	
will start automatically. 

Occasionally, you may encounter problems 
while installing StrikeRisk.  
Some troubleshooting tips are given 
below that may resolve the problem.
If you have any further questions, contact 
Furse Technical Support.
•	 Check to make sure there is enough 

free disk space on your hard disk to 
meet the system requirements. (The 
setup process should notify you if 
there is not enough free disk space 
prior to installation.)

•	 Before installation, shut down any 
running 	programs, including virus-
checking programs. (Usually, virus-
checking software has little or no 
impact on the installation process; 
however, if you are running such 
software and encounter 			 
difficulties with your StrikeRisk 
installation, turning off the virus-
checking programs and then re-
installing often resolves the problem.)
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Uninstalling StrikeRisk

•	 Delete any files in your temporary 		
folder. (This folder is determined by the 
TEMP environment variable. Usually it 
is located in C:\Temp or C:\Windows\
Temp.)

•	 Run a disk-scanning utility. 			 
Hard disk errors can cause problems 		
with the installation process. 		

(Some Microsoft Windows systems 		
contain a utility named Scandisk. 

•	 If you have questions about                   		
disk-scanning utilities, talk to your 
system administrator.)

•	 Copy the StrikeRisk setup CD to your 		
Hard disk, then run setup.exe from 
your hard disk.

Furse recommends that you uninstall any 
older versions or evaluation versions of 
StrikeRisk prior to installing new 
versions. Running multiple versions of 
StrikeRisk applications on the same 
computer is not recommended or 
supported by Furse.

Before uninstalling StrikeRisk
Use the following steps to protect 
existing information you may have on 
your system.

Save existing StrikeRisk projects
Uninstalling removes program files only – 
project files you created in StrikeRisk 
remain on your system. We do 
recommend, however, that you copy and 
move any projects you saved in the 
StrikeRisk folder to another location on 
your hard disk (such as in your My 

Documents folder) before 
uninstalling StrikeRisk. 

To uninstall StrikeRisk 
(based on Windows 7):
a. From the Start menu, select 
Settings – Control Panel.
b. Click on Uninstall a programs.
c. From the list of programs that you can 		
remove, select StrikeRisk v5.0
(or StrikeRisk if uninstalling version 4.0).
d. Click Uninstall.
e. At the prompt, click Yes to confirm 
that you want to remove the program.
f. The uninstall program removes 
program files, folders, and registry 
entries. 
g. When the files are removed, the 
uninstall program indicates that the 
process is complete. Click OK.

I N S TA L L I N G S T R I K ER I S K
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—
Activating StrikeRisk
Overview

StrikeRisk is activated by a USB Security 
Key (sometimes known as a hardware lock 
or a dongle). Product activation ensures 
that a particular product is not used 
on more computers than is allowed by 
the end-user license agreement (EULA). 
Activation is simple and takes only 
a moment.

A full licensed copy of StrikeRisk is 
supplied complete with a dongle.  
The dongle must be activated to allow 
StrikeRisk to run beyond its 15 day 
evaluation period. 

The following activation procedures are 
specific to either:
•	 Standalone dongles
•	 Network dongles

One standard dongle for each user of StrikeRisk

—
Standalone dongles

Standalone dongles are green in colour.

Standalone dongles are supplied when 
Furse Part No. SR600 is purchased.

A Standalone dongle is required to allow 
StrikeRisk to run (once the evaluation 
period has expired) on a single 
workstation with StrikeRisk installed. 
The Standalone dongle must be present 
and detected in a USB port of your PC to 
allow StrikeRisk to run on that same PC.

StrikeRisk v6.0 cannot be activated by a 
StrikeRisk v5.0 dongle.

For details of the activation process see 
Activating Standalone (green) dongles 
on page 12.

Operator workstationDongle CD
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Network dongles are blue in colour.

Network dongles are supplied when 
Furse Part No. SR602, SR610 or SR699
is purchased.

A Network dongle is required to allow 
StrikeRisk to be run (once the evaluation 
period has expired) by multiple users 
concurrently on multiple workstations 
(with StrikeRisk installed) up to a fixed 
number of licenses.

For details of the activation process see 
Activating Network (blue) dongles on 
page 12.

—
Standalone dongles

—
Network dongles

Operator workstation Operator workstation Operator workstation

CDCDCD

CDDongle
Network One Network dongle on a server

allowing multiple users of StrikeRisk
up to a fixed limit

DinkeyServer application (available from installation CD) 
running on the server constantly monitoring licenses

AC T I VAT I N G S T R I K ER I S K
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Place the Standalone (green) dongle 	
(hardware lock) into an empty USB port 
of your PC. Your operating system should 
be set up to recognize new hardware 
automatically.

The Network (blue) dongles can be 
connected to any machine (not 
necessarily a server) that is running any 
version of Windows, Linux or Mac OSX. 
We refer to this machine as a dongle server.

In order for the Network (blue) dongles  
to work correctly you need to install 
DinkeyServer on the computer that the 
dongle is attached to. On the client 
machines your protected software will 
automatically search the network for 
DinkeyServer which will communicate  
with the dongle on the server. 

—
Activating Standalone 
(green) dongles

—
Installing and configuring 
DinkeyServer

—
Activating Network 
(blue) dongles

Insert the Network dongle
Place the (blue) Network dongle into an 	
empty USB port of the dongle server. 
Your operating system should be set up
to recognize new hardware automatically.
NOTE: This part of the process is identical to 
that followed for a standalone dongle.

Running DinkeyServer
The DinkeyServer program needs to be 
running on the dongle server for dongle 
checking to function.

a. Copy the file DinkeyServer.exe from the 	
installation CD i.e. D:\DinkeyServer.exe 	
(where D: is your CD drive) to a directory 	
on the dongle server i.e. the machine that 	
the Network Dongle is attached to.
	
b. Run the file DinkeyServer.exe by double 	
clicking the DinkeyServer icon. If Dinkey	
Server fails to find a Network dongle 
you will be notified with the following
error message.
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c. If when DinkeyServer is run, it finds one 
or more Network dongle(s) you will be 
notified with the following dialogue.

d. Choose to run DinkeyServer as an 	
Application or as a Service (daemon 		
under Linux) by clicking on the radio 		
buttons under Startup Modes.

A Service starts automatically when the 	
machine is booted and does not require a 		
user to be logged in for it to run. Starting 	
DinkeyServer as a Service is the 			 
recommended setting for general use.

An Application requires a user to be
logged-on for it to run. This may not 	
always be the case on server machines. 	
You may want to start DinkeyServer as 
an Application if you want to test it. 

NOTE: Under Windows if you choose to run 
DinkeyServer as an Application and want to have it 
start automatically when the user logs in, then you 
must create a shortcut to DinkeyServer in that 
user’s ‘Startup’ folder and specify the appropriate 
command-line parameters to make DinkeyServer 
start automatically.

 
e. The Network Configuration section 
allows you to configure the network 
settings that DinkeyServer will use. 

In Automatic mode, DinkeyServer will 
automatically choose the settings based 
on the best defaults combined with any 
existing configuration settings. This is the 
recommended setting. 

Custom mode allows you to manually 	
specify the IP address and port that 		
DinkeyServer will listen on.

f. To start DinkeyServer click the Start 
button. It will then either run as an 
Application and launch the viewer screen 
or install itself as a Service and run in the 
background.

You will need to have Admin Rights to 
install a Service. 
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When DinkeyServer is running as an 
Application, it will display the DinkeyServer 
Viewer. This utility displays the status 
of DinkeyServer, the Product Codes it is 
serving and the network users currently 
connected to it. A DinkeyServer icon will 
appear in the Windows System Tray.

You can also open the server’s log file 
using this utility. The log file records 
important events during the running of 
the server and may need to be viewed 
to diagnose problems.

When DinkeyServer is running as a Service, 
it will not display the viewer because 
Services cannot display Graphical User 
Interfaces (GUIs). However, you can still use 
the DinkeyServer Viewer by running 
DinkeyServer.exe with the /viewer 
command-line parameters.

—
DinkeyServer viewer
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The StrikeRisk user interface consists of 
the following main parts: 

1. Title bar
The Title bar, which is a horizontal area at 
the top of the StrikeRisk window, provides 
the filename of the currently Open Project.

2. Quick Access Toolbar
The Quick Access Toolbar is a 
customizable toolbar that contains a set of 
commands that are independent of the tab 
that is currently displayed on the Ribbon. 
You can move the Quick Access Toolbar 
from one of the two possible locations, 
and you can add buttons that represent 
commands to the  Quick Access Toolbar.

—
User interface
Overview

12
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U S ER I N T ER FAC E OV ER V I E W
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3. The Ribbon
The Ribbon is designed to help you quickly 
find the commands that you need to 
complete a task. Commands are organized 
in logical groups, which are collected 
together under tabs. Each tab relates to a 
type of activity, such as viewing reports. 
To reduce clutter, some tabs are shown 
only when needed. The function of a button 
is displayed when you position the mouse 
pointer over a button and hold it there for 
a short time. If a button is grayed out, this 
means it is not available at present.

4. Summary pane
The Summary pane displays a summary 
of the key results of the currently selected 
(open) Case. All four primary risks are 
shown along with their direct and indirect 
components. Risk results are colour coded 
to quickly identify if they are higher or 
lower than their tolerable value.

5. Case pane
The Case pane is the area in which 
all currently open Cases are shown 
and manipulated.

6. Active Case
The Active Case is the currently selected 
(open) Case and is displayed in front of 
any other open Cases.

7. Results pane
The Results pane displays detailed results 
of the currently selected (open) Case. 
For each of the primary risks selected a 
separate grid of results is displayed. Each 
grid displays all of the risk components, 
per zone and per line that go to make up a 
primary risk. Risk results are colour coded 
to quickly identify if they are higher or 
lower than their tolerable value.
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Customizing the user interface

Full Ribbon

Minimized Ribbon

You can change the program’s user 
interface based on your preferences. The 
View menu provides options for hiding 
and displaying toolbars, panes, and other 
WYSIWYG (What you see is what you get) 
elements. 

Here are some ways of customizing the 
work environment:
•	 Adjusting pane size
•	 Adjusting the visibility of the Ribbon
•	 Adjusting the location of the Quick 

Access Toolbar

Adjusting pane size
The program’s user interface is divided 
into three main areas (panes):
•	 Case pane
•	 Results pane
•	 Summary pane

You can adjust the widths or heights of 
the above panes to make them smaller or
larger by:

a. Place the pointer over the edge of the 		
divide between the two panes. The 
pointer turns into a line with arrows on 		
each end          or   .

b. Press the left mouse button and drag 
left or right, up or down. The pane is 
resized after you release the mouse 
button.

The program maintains these settings 
until you adjust the panes again.

Adjusting the visibility of the Ribbon
By default, the Ribbon is displayed across 
the top of the window, below the Quick 
Access Toolbar as shown below. There 
is no way to delete or replace the Ribbon 
with other toolbars or menus. However, 
you can minimize the Ribbon such that 
only its tabs are visible to make more 
space available on your screen.

U S ER I N T ER FAC E
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To adjust the visibility of the Ribbon:
a. Move your mouse cursor to the top right 	
hand corner of the Ribbon to just below 		
the red Close button.

b. Click the button to toggle the visibility 
of the Ribbon between the two states 
shown above.

Adjusting the location of the 
Quick Access Toolbar
By default, the Quick Access Toolbar is 
displayed in the top left hand corner of the 
window, above the Ribbon. You can adjust 
the location of the Quick Access Toolbar 
to a position directly below the Ribbon.

To adjust the visibility of the 
Quick Access Toolbar:
a. Move your mouse cursor to the right 
hand side of the Quick Access Toolbar.

b. Click the button to display the 
Quick Access Toolbar menu.

c. Toggle the location of the Quick Access 	
Toolbar by selecting Show Below the 	
Ribbon or Show Above the Ribbon.

Above the Ribbon

Below the Ribbon

Adjust the visibility
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Basis steps
Your how to guide

Opening the program
After you install the program, a StrikeRisk 
icon is displayed on your desktop.  
How StrikeRisk opens depends whether 
the program has been activated or if it is 
running in evaluation mode.

To open StrikeRisk running in 
evaluation mode:
a. Double-click the StrikeRisk icon on  
your desktop. The following dialogue box 
is displayed. At the top of the dialogue a 	
message indicates the number of days 	
remaining before the program must be 	
activated to run.

 

b. Click Run the product (if the 15 day  
limit has not expired), then click OK.

c. The program splash screen is displayed 	
and the user interface is loaded.

d. Once the 15 day evaluation period has 
expired the option to Run the product is 	
disabled as shown in the following 
dialogue box. The program must now be 
activated by a valid hardware lock before  
it will run.
 

e. Click Purchase the product, if you do 
not have a valid hardware lock, then click 
OK. Your web browser will open an take 
you to the StrikeRisk pages of  
www.furse.com where you will find  
details about purchasing StrikeRisk.

To open StrikeRisk activated by a 
Standalone (green) dongle:
a. Double-click the StrikeRisk icon on 
your desktop.

b. The program splash screen is displayed 	
and the user interface is loaded.

B A S I C S T EP S



20 S T R I K E R I S K v 6 .0 I EC/EN 6 2 3 0 5 - 2 R I S K M A N AG EM EN T S O F T WA R E

To open StrikeRisk activated by a 
Network (blue) dongle:

The first time that StrikeRisk is run:
a. Double-click the StrikeRisk icon on 
your desktop.

b. Providing that the Network (blue) 
dongle has been activated (see page 12) 
and that DinkeyServer is running, the 
program splash screen is displayed and 
the user interface is loaded.

If the Network (blue) dongle has not been 
activated (see page 12) or DinkeyServer 
is not running, the following Product 
Activation screen will appear.

Closing the program

Select the File tab of the Ribbon,  
select Exit.
NOTE: You may be prompted to update and or 
save files before the program Exits.

Creating or opening a Project

Use the following procedure to create a 
new StrikeRisk Project or open an 
existing Project.

To create a new StrikeRisk Project:
a. From the File tab of the Ribbon, 
select New.

b. A number of new Project templates 
appear in the File window.

c. Click the template button that relates to 
the relevant standard.

To open an existing StrikeRisk Project:
a. From the File tab of the Ribbon, select 	
Open Project... The Open Project 		
dialogue appears.

b. In the Open Project dialogue, click the 	
Look in dropdown box and browse to
the directory where your Project files 
are stored.

c. Select the required Project file.

d. Click Open. The chosen Project opens.

NOTE: To see examples of StrikeRisk Projects 
open the sample projects that are included in the 
StrikeRisk installation. The sample projects are 
located in the Samples subfolder of the location 
where you installed StrikeRisk.



21

Developing a Project

The following is a recommended strategy 
for developing a Project within StrikeRisk. 
Not all of the tasks are necessary to 
develop a Project, but you will probably 
want to complete most of them.
•	 Create a new Project
•	 Define the Project properties
•	 Develop an original Case
          - Define the Environmental 
         influences
          - Define the Primary Structure (the 		
           structure under consideration)
          - Define any connected Secondary 		
           Structures
          - Define any connected Lines
           - Define any Zones (areas) of the            
          - Primary Structure with common           
           characteristics

•	 Develop one or more solution Cases  
(if necessary)

•	 Define any Protection measures

Developing Cases

The heart of each StrikeRisk Project is 
its Cases. Each Case is a separate risk 
assessment in its own right.

Each Case is used to carry out a series 
of calculations using relevant formulae 
to determine the actual risk R for the 
Structure under review. The designer 
must ascertain/decide the type of losses 
relevant to the structure, enter a number 

of dimensions and various weighting 
factors relative to the Structure, along 
with various assigned values from the 
appropriate tables in the Annexes of IEC/
EN 62305-2. All of the foregoing can be 
entered or is accessible within each Case.

The calculated risk R is then compared to 
its corresponding value of RT.
If the result shows R <= RT then the 
Structure is adequately protected for a 
particular type of loss.

If the result shows R > RT then the 
Structure is not adequately protected 
for the type of loss, therefore protection 
measures need to be applied. These 
protection measures are determined from 
relevant tables given in IEC/EN 62305-2. 
Again these can be set within each Case.

The aim, by a series of trial and error 
calculations is to ultimately apply 
sufficient protection measures until the 
risk R is reduced below that of RT.

B A S I C S T EP S
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Generating reports

The ultimate aim of StrikeRisk is to 
produce the results of IEC/EN 62305-2 
Risk Management calculations in a format 
that can be passed to a customer or easily 
incorporated within the documentation of 
an engineering project.

StrikeRisk allows you to review/generate a 
number of different forms of output.

A full report can be produced for the 
currently selected Case. A full report lists 
all input factors as well as all calculated 
values and resultant risks.
 
A summary report can be produced for the 
whole project. A summary report shows 
the overall calculated risks and protection 
system design parameters for each case in 
the current Project.
 
In addition to being printed directly, 
reports can be exported in either Excel, 
Word or PDF formats.
 
Reports can be customized to 
automatically add company logos to  
the front and following pages.

Getting help
 
Available via the View tab of the Ribbon, 
StrikeRisk has an extensive online help 
system. StrikeRisk Help describes 
the main interface of the StrikeRisk 
software package. It shows how to start, 
navigate and utilize the various parts of 
the package and describes all of their 
functions.
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Notes

N OT E S



—
ABB Limited
Furse
Wilford Road
Nottingham NG2 1EB
United Kingdom
Tel: +44 (0) 115 964 3700
E-Mail: enquiries@furse.com

www.furse.com

© Copyright 2018 ABB. All rights reserved. 
Specifications subject to change without notice.

9A
K

K
10

10
3A

59
75

 R
ev

 A
.


